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Topics Learning in the exercise

1. Buffering
2. Dissolve

3. Merge

4. Clip

5. Intersection
6. Union

7. Spatial Join
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1. Buffer

1.1 Loading the buffer menu

1.2 Creating buffers around all features in a theme

1.3 Creating different buffers in a theme

1.4 Creating buffers around selected features in a theme

1.5 Selection within buffer



1Eme
Broperties. .

1.1 Loading the buffer menu

Start Editing

Save Edits

Save Edits Az
Conwert to Shapefile. .
Corvvert bo Grid...
Sawe [Mata Sef..

Edit Legend...
Hide/Show Legend

-Add theme “District_hospital.shp™

Fe-matchdddrezses,..

-Select Create Buffer at theme menu

Chrl+L
[ChrlH

Auto-label...

Femave Labels

Femave Dverlapping Labels
[Eonwert Oyverlapping Labels  Chlsd

-If Create Buffer option is disappear, \

It’s because of unsetting of View’s properties

Table...
Cluerny...
Select By Theme...

Chrl+(]

[Create Butfers...

Clear Selected Eeatures

Edit Theme Expression...

-Go to View menu and select Properties g

M ame:

[ Vieaw

Creation Diate:

| 20 AT0E4 2003 03:21:49

-Select Map Unit and Distance Unit

Creator: |

-Click OK

'Ilw Theme Analysis  Surfa

Add Theme. .. Chrl+T
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1.2 Creating buffers around all features in a theme

-Activate theme “District_hospital.shp
-Select Create Buffer at theme menu
-Once Create Buffer wizard is loaded .
-Select the feature of a theme name | e

: Save Edits Az,

“District_hospital.shp™ Convet o Shapefe.

i Corveert to Grid...
- 4
-Then click Next>> button o
i Create Buffers x| Hide/Show Legend

Ahalyziz  Surface  Graphics

Eroperties...

T T O

He-matzh Sddresses,

What do you want to buffer?

About buffers

Buffers are rings drawn around " The araphics it pourn wiew Suto-label... Chrl+L
features at a specified distance ; Hemove Labels [Ctrl+H
from the features. i The features of a theme

Hemove Dyverlapping Labels

| District,_hospital shp ‘k Lorwvert Dverlapping Labels  Ehl+0

Table...
Cluerny... Chrl+C1
Select By Theme. ..

Mumber of features selected: 0
[ Usze anlythe selected featines Clear Selected Eeatures I E
i Edit Theme Expression...
Cancel L4 Mext »» ‘

Murnber of features: 15

GAC/AIT/Jul2004
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e
# Create Buffers *
/ X| ! Create Buffers %]

How do you want to create buffers?

Disgolve barriers
I between buffers? = Mo @ & ‘es @
At & specified distance I 10 O O O

o8

At a distance from an attibute field

|Wecode =] ] O e

Az multiple rings

YW'here do pou want the buffers to be saved?

rumber of rings: 3
dist bet . I @ @ @ i~ az graphicz in the view
istance between rings: 500 ) N
" in an existing theme [ Buffer 1 of District_hospital sho E3|
Distance units are: [Kiometers ) | ¥ in anew theme I d:\hrainingshealth-gissbuff_dh.shp
Help... | Cancel (U Back Meut »>
= | | i Help. . | Cancel | << Back | Finizh Y !

-Define buffer properties

_ « District_hospital.sh |2
-Click Next >> :

] ] «] Buffer 1 of D Etrict_
-Select Dissolving of buffers [ ®
-Select a way to save buffers @

-Click Finish QD @

-Open buffers to View Window @@

il 0

||

\ Buffers 10 Km. of district hospitals
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1.3 Creating different buffers in a theme ="

In order to specify distance of
Health facility’s serviceable area.
This step we will create

different sizes of buffer based on

type of health facilities.

-Activate theme
“Health_facility.shp”
-Select Create Buffer at
theme menu -
-Select the feature of a theme name
“Health_facility.shp”

-Then click Next>> button

GAC
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£ Fi T
e Field Definition EI Asian Institute of Technology
Open attribute table of pae, Toemee £ =
Type: | Mumber hd
I = Cancel
“Health_facility.shp” v |
|
#! Attributes of Health_Ffacility shp Decimal Places: I 0
L Shape | Yecode |[Deode|Poods Vhamee I TTaTTET I T TPEE T I Type
-Se I eCt Start ed Itl n g Point 1309038 1309: 13 PHONMOUANG o Phane dok dispenzary 4: DISPENSARY -]
Foint 1309045: 1309: 13 LAMCHAMNH KAMG JeSaodk’ Mong lam chanh dispensar 4: DISPEMSARY
Poirt 13090581 1309¢ 13: KHORNTARE OvocSh Kore tee 4 DISPEMSARY
Point 1309065 1309: 13 BEUKTHOMG [bdmg)' Buik thong dispensary 4 DISPEMSARY
a’t I ab I e men u Poit 1309053 1309 13 HOUAYMAKGNAD sh:ps kdopgk Huay mak yan dispensary 4 DISPENSARY
Paoirt 1309074 : 1309: 13 SAKHEUMN TAl -t7ba. Bh Sa kiun tai dispensam 4 DISPEMSARY
Point 1309079 1309: 13 KHAMTHAD Ok, qd ik K.am tao dispensary 4 DISPEMSARY
Foint 1309098 1309: 13 LAMBONG el Lam bong dizpensam 4: DISPEMSARY
= Point 1309105 1209 13 KHAMMNOY Teohvp F.ham noi dizpenzam 4 i DISPEMSARY
- n eW I e O Point 11303770¢ 1309: 13 MATEUY MELUA okgBupgsony Ma teun dispensarny 4: DISPENSARY
Point 13031141 1309: 13 BAK [kd Bak dizpenzan 4 DISPEMSARY
Point 1309117 1309F 13iNADOU okfE Ma khu dispensary 4 DISPEMSARY
e - Bhgint 13091261 1309:  13) KENGROKDONG cdh'dvdig' Champhone district hospital 3 DISTRICT HOSPITAL
N am e Se rVI Ce K M Foit 13001341 13097 131 SALIPAKOUAY Ik dhzp Pa kuai dispersary 4 DISPEMNSARY
—_— Paint 1309740¢ 1309: 13 TALED Mal Bkos": g Ta leao dispensary 4 DISPENSARY
FPairt 1309155 1309: 13 LAOMAT alqikz kf Lao nath dizpensany 4: DISPEMSARY
Point 1309161 1209 13 HOUATYSAY sh;p-kp Huay zai dizpensan 4 i DISPEMSARY
Foint 1310018 1310: 13 MAPHENG okcr' Ma pheng dispensary 4: DISPEMSARY
= I O SpeCI IS an Ce Poirt 13100291 1310F 13 NONSAWANG Soolts k' Sonebuly district hospital 3 DISTRICT HOSPITAL
Point 1310054 13108 13 LAMTHOUAY lemkp Lam tuai dispenzary 4 DISPEMSARY
Foint 1310084 ¢ 1310: 13 MUANGPHOMNG a.rw'2hy' Muang fong dispensary 4: DISPEMSARY
Of health faC - I .t y S Pivint 13110021 1311 13§ KENGKABAD TAl cdh'dtalak. Bh #avbuly distict hosoital JDISTRICT HOSPITAL I:I
I I 4 3
y ! Attributes of Health_Facility.shp -0l x|
. Fields Yalues
servi Ceab I e [Vname] "DISPENSARY" -
. o [inamel] "DISTRICT HOSPITAL™
" [Mame]

Use Query Build Tool find  iw—

[Service kM)

Type of health facilities and define (Type] = PROVINCIAL HOSPITAL”)

Add To Set

distance of serviceable.

- Select From Set
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-After selected a type of health .
Fields Type Requests
=al= * Mumber -
Facility, use Calculator tool ‘ E \ Ve Comg | 0
(Peoda] i Date
- - [Wrhamee] /
To define distance of buffer. o B— . =
[Service_KM] =
10 -
. j Cancel
Condition: -
Provincial Hospital = 10 Km.
DiStriCt HOSpitaI — 5 Km- 2 Attributes of Health_Facility.shp ;lglﬂ
1 — Fields Walues
DISpensary =2 Km. [Vnamee] B E| "DISPENSARY"
[t ] "DISTRICT HOSPITAL™
['\l:l‘la'::;.]3 "PROVIMCIAL HOSPITAL™
W
[Type] -
2 Field Calculator x| [Service_KM] il
hd ¥ Update Values
Fields Type Requests
& Nurmber " [[Tupe] ="DISTRICT HOSPITAL" ] - | Fiam B k
Eccroncdhz]]  Shing : 1 AddTaSet |
[Peode] " Date i}
[¥namee] ! - Select From Set |
ICOEIE ¢
[M ame] ﬂ = LI
[Service_kM] =
g =
j Cancel
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- - - - " 2 1 = D £a l L
- O n Ce fl n I S h e d I n p u tt I n g Shaps| Vs | Dot Lo Vinzmee [ Hame T Tam Sersaine A
! Faint a a a 1: PROVIMCIAL HOSPITAL 10
Point 1303050 1303: 13} MalNAHOU .5.jokmEh Palannay district hospital J:DISTRICT HOSPITAL 5
Foint 1304002 ¢ 1304 13 PASOMXAY st - Phine district hozpital 3iDISTRICT HOSPITAL 5
S e I e Ct S ave an d Sto [ Point 1303023 1303 13 TABONGPHET B[v'araf Atsapanathong district hosp 31 DISTRICT HOSPITAL 5
Paint 1310029¢ 1310 13 MOMSAVANG Joolksjk’ Sanebuly district hospital 3:DISTRICT HOSPITAL 5
Faoint 1311002 ¢ 1311 131 KEMGKABAD TAl cdh'diggk. 8h #aybuly district hospital JiDISTRICT HOSPITAL 5
Point 7309126 1309: 13 KENGKOKDONG cdh'dwdfg’ Champhaone distict hospital JiDISTRICT HOSPITAL 5
il i - Point 1301110¢ 1301 131 DANH fiko Hayphuthong district hospit JIDISTRICT HOSPITAL 5
E Itl n g I n Ta e M e n u . Paoint 3312052 ¢ 1312: 131 BOUNG [5) YWilabuly district hospital FiDISTRICT HOSPITAL 5
Foint 91301128 1301 13 MAKHAM MLA ok Fegeony Ma kkham disperzany 4 DISPEMSARY 2
i Paoint 1301119 1301 13 PHONSOMPHONG Srold, 31" Phone som hong dispensar 4: DISPEMSARY 2
Point 1301106 ¢ 1301 13: THAPHO ik Tha pha dispensary 4: DISPEMSARY 2
- T h e n S e I e Ct C re ate B u ff rEint 1302041 ¢ 1302 13: PHOMEDEUA Srogfnjv Phone duea dizpensary 4 i DISPEMSARY 2
Boint 1302058 13021 13 PHOMEPHANG Srozk! Phane fang dispenzany 4 DISPEMSARY 2
Foint 1303009: 1303 131 MACHANH okSko Ma chan dispenzary 4 DISPEMSARY 2
Foint 13030014 1303: 13: DONGKEUM fg'db, Dong kuem dispenzary 4 DISPEMSARY 2
Foint 1302045 1302 131 NAPHDAY ok 3. Ma pho zai dizpenzary 4 DISPENSARY 2
I n T e m e M e n u . Point 1301102 ¢ 1301 13 PHAKKHA GMNAI zadlt.sip Phak ka dispensary 4: DISPEMSARY 2
Foint 9303045: 1303: 13 MAICHATSANH .5.j3aflao ay boua thong dispensan 4 DISPEMSARY 2
Point 4301076 1301 131 BOGKANG -¢ddk’ Sork dispensary 4 DISPEMSARY 2
171 mg = Paint £a0T062 ¢ 1301 13§ PHOMSIM MUA Sraly gzony Phane sim dispenzany 4 DISPEMSARY 2
- S e I e Ct H e al th faC I I I ty S T 304062 13047 13 HOUAYKHAM shiofe Ma thom disoensary 4: DISPEMSARY 2
0 4

As the features of a theme, then click at the 2" option in next window.

Howa do o want bo create bulffers?

YW'hat do pou want to buffer?

About buffers

Bulfers are rings drawn around " The graphics in peur view " At a specified distance I 1 O O O
features at a specified distance .
fram the features. * i The teatures of a theme:

| Health_faciity. shp =] A a distance from an attibute fisld

™ Az multiple rings
Mumber of features: 77 riumber of ringz: I 3
MNumber of features selected: 0 distance between rings: 1
[ Use anly the selected features Distance units are: | Kilometers / =]

| Mest 35 | Help... | / Cancel | << Back | Hemt 5

Cancel |

-Choose a field to define distance of buffers



G

.

ﬂ Buffer 1 of Health_{ %
|
_ | Heatth_facility.shp
a
o " ° e
i Create Buffers x| © o o ]
Dizzolve bariers 0290
between buffers? Mo @ & Ves @ O o O
o 0 Q e o
og o}
[o 0] o o
(o]
9 . Q
o] Ob o]
O O o
0 0o
) o
YWwhere do wou want the buffers to be saved?
_ . OO o
" az araphics in the vigw o
(i an exsting theme | =]
¥ in anew theme ||:|:'xtrainingEEIEl#'xminipru:uieu:t'xserviu:e_hf ||
Help... | Cancel «Back | Fish |
' TT= THRIC T 0
+ DISFENSAR] o
ﬂ Semice_hfshp % &-‘E} @ @
ﬂ Willage=shp & @
@ @ @ @ ® 3] @
R Elg ® @
feati] &
% ¢ ® ®
s, ® ®e o

L]
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1.4 Creating buffers around selected features in a theme

The interested roads that we
will make a buffer is National
road. Therefore this road need
to be selected before buffering.

-Add theme “roads.shp”
-Click Query Builder tool
-Type an expression

ﬂ Roads.=zhp

Liztrict R oads
Mational Raoax
Frovincial B o

Rural R nads

e

|41

LB, M
My |: e
'H-\...'}Tﬂ\ . e e
{ _ 5\
x“-""\
N L\\
Y
oy .

-Select Create Buffer in Theme menu

#2 Roads.shp

Fields
[Offzet_end]
[Surf_tupe]

Yaluesz
"Diztrict Roads"
"M ational Roads"

[Road_con] "Provincial Boads"
[Lengthl] not "Rural Foads"
[Rd_conditi] J
[Prode] ;I v Update Yalues
[[Rd_type] = ] - | Mew Set I
AddToSet |
- Select From Set |

=101 x|

# Create Buffers

About buffers

Buffers are rings drawn around
features at a specified distance
from the features,

Ww'hat do pou veant to buffer?

" The graphics it o view,

+ i The features of a theme!

| Roads. shp

Mumber of features: 978

Murnber of features selected: 138

M Use only the selected features

Cancel




#! Create Buffers

Heawe do you want to create buffers?
At 5 specified distance I E

" At a distance from an attribute field

| Friode_ =l

A multiple rings

nurmber of rings: I

3
diztance between rings: ]
Distance units are:; | Kilorneters 3|

Help... | Cancel | << Back | Mext »> |

-Select buffer properties
-Navigate buffer of road
to the working directory
-Add buffer of road theme
in View window

i Viewl

#! Create Buffers

Dizzolve barriers
between buffers? Mo

Where do you want the buffers to be saved?

Geoinformatics Center

Asian Institute of Technology

x|
@] [

" as graphics in the view

¢~ it an edigting theme |

=l

s in anew theme |d:'\training\health-gi&'\buff_rd.Sh|:|

Help... |

Cancel ¢ Back | Firizh I

ﬂ Roads shp

ﬂ Buffer 1 of Roads =
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1.4 Selection within buffer
Once you have defined your buffer area, you may want to find how many villages fall
within the road buffer. x|

-Add theme name “Village.shp”

[ Intersect ;K | Mew Set

I
-Add buffer of road which we have s :
done in previous step

. . ’ Cancel I

mmmmmmm—  -Activate “Village.shp
AN Snalpsis  Swrface  Graphics |

- -Choose Select By Theme in Theme menu

=i -Select method to select and buffer theme, then click New Set

Convert ta Shapefile. ..

5:::3:2?2? o vilageshp =

Edit Legend... .

Hide/Show Legend ] Bufi_rdshp ‘

Fie-mateh Addresses... -

Buto-label... Chrl+L

Hemowve Labels [Chrl+H
Femove Oyerlapping Labelz
[Eormert Dyverlapping Labels, Chil+0

Table...
Query... Crl+0)

Select By Theme. ..

Create Buffers. ..

Clear Selected Eeatures

Edit Theme Expression...
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2.Dissolve

2.1 Open new view window and Add Theme
2.2 Loading Geo-Processing Wizard

2.3 Create Provincial Boundary from District Boundary
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2.1 Open new view window and Add Themae"

-Add Theme “District.shp”
-Open Its attribute in order to

select a field use for dissolve

i Attribvices of Distsict.shp | e
Shgoe |\ Fladts Leota Fa3aa g ar S Am ‘m'
: Polygon Ss—az 1312 § Wilabori 1765107479.680 17EE 107 | S _:
Falygon 13 1317 i ®aibouri 395345602959 895,946 : SAVANMAKHET
Palygaon 13 1313 Atzaphon 1452316064.602 1452316 ¢ SAVANMNAKHET
Palygon 13 1305 ; Xepon 2266782030519 2266.732 : SAVANMAKHET
Palygon 13 1302 § Outhoumphon 1082417234 996 1082417 ; SAVANMAEHET
Palygon 13 1315 Phalarnsai 99807E535.390 998,077 : SAVANMARHET
Palygon 13 1303 § Atzaphangthong FO0937798.695 700,933 : SAVANMARHET
Polygon 13 1304 § Phin FIFA 24542212 FI72125 SAVANMARHET
Falygon 13 1301  Khanthabori B81611273.958 B31.611  SaVAaMMARHET
Falygaon 13 1309 i Champhon 1043758789.065 1049.759 § SAVAMMARHET
Falygon 13 1306 § Mong 1700596082, 260 1700.596 : SAVANMNAKHET
Palygaon 13 1310 ¥onboun 1205959535.145 1205.960 ¢ SAVANMNAKHET
Palygon 13 1314 ¥aiphouthong 4R4822663.925 454 823 SAVANMAKHET
Palygon 13 1308 Songkhon 1635316539 466 1635.817 ; SAVANMAEHET
Palygon 13 1307 i Thapangthang 2115852184 956 2115.852 ; SAVANMAERHET |
GAC/AIT/Jul2004 « |




2.2 Loading Geo-Processing Wizard

-Select Extension in File menu
-Check Box in Geopocessing
-Click OK

-In View menu, click
GeoProcessing Wizard
-Choose the 15t option
-The click Next>> button

GAC/AIT/Jul2004

! GeoProcessing

i ArcView GIS 3.3

Edit  Wiew Theme Suw

LCloze

Close Al [::>

Set Working Directory.
Save Project Chil+5
Save Project Asz...

Choose a GeoProceszing operation,
then click the Mest button to choose
optianz.

& Dissolve features based on an attibute

(i e themes together

" Clip one theme bazed|am anather
" Intersect bwo themes

" Unian bwo themes

£ fzsign data by lozation
[Spatial Jaim]

Geoinformatics Centet
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! Extensions x|

Awailable Extenzions:
| Digitizer 2 oK. |
_ | ER Mapper Algarithrmz and Images Sur
) Cancel I
Geoprocessing
raticules and Measured Grids
Reset |

| Grid Analpst Extengion [Wer1.1]
[~ Make Default

| Hydrologic Modeling «1.1 [zample]
| IMAGINE Image Suppart LI

About:

About Dissolve

This operation aggregates
features that hawve the same
value for an attribute that you
specify.

Input Ciutput

i Eroperties. .

S AddTheme.  ChhT

= [Feocode dddieszes...

= ! Add Event Theme, ..

E: Mew Theme. ..
Themes On

" Themes Off

n Layou...

| TOCSHe.

<:| ]' Full Extent

Zaari In

' Zoom Out

tdore about Dizzalve

Help... |

Cancel < Bl | Mest s
Eind. .. Chl+F

T Theme Graphice  ®=Too

coom Ta Themes
Zoom Tao Selected

Zoom Prexious

L ozate Address...

GecFroceszing \Wizard. .




2.3 Create Provincial Boundary from District BoUR&aRy™

-Select “District.shp” as theme

to dissolve

-Select “Pcode” as an attricute

to dissolve

-Click Next>> button

-Choose field and operations
To be added in the output file

-Press Shift button in keyboard
and click for many fields

-Click Finish button

GAC/AIT/Jul2004

#! GeoProcessing

Dizzolving [alzo called "'zummarizing'
or "aggregating’'] merges features to
form new regionz bazed on an attribute
of thoze features.

1] Select theme to dizzolve:
| Digtrict.zhp -]

2] Select an attribute to dizzolve:

| Peode |

3] Specity the autput file
Output File: | d:training 20044 miniprojectspr

ntet

X

Ahout Dissolve

This operation aggregates
features that have the same
value for an attribute that you

specify.

Input Cutput

tare about Dizzolve

Help... |

Cancel << Back |

#} GeoProcessing

Chooze one or more additional
fields and operations to be
included in the output file:

Sq_km by Average

S _krn by Sum

S _km by Minirmum Y alue

Sq_km by M aximum ¥ alue

Sq_km by Standard Deviation

Sq_km by Variance

About Dissolve

This operation aggregates
features that have the same
value far an attribute that you

specify.

Input Cutput

tore about Dizzolve

Cancel << Back | Finizh *
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-Display output theme (Province.shp)
-Open Theme Table|2)]

«7 Province.shp =

[ ]

| Districtshp

[
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3.Merge

3.1 Open new view window and Add Theme
3.2 Create whole administration boundary by merging

3.3 Display the administration boundary



3.1 Open new view window and Add Themes

-Add themes “Lao-n.shp”,
“Lao-c.shp” and “Lao-s.shp”

<1 Attributes of Lao-n.shp

Geoinformatics Centet

Asian Institute of Technology

ﬂ Laog-=.shp
L]
ﬂ Lao-n=shp
L]
ﬂ Lao-c.shp
[ ]

Shsne | Pt Findana g Sy A

Palygon RiBOKED E932252954.09 E932.25 | & |
Falygon 7 i HUAPHAMH 17504314822 48 17504.31
Folygon 31 LUAMGHNAMTHA, 9595355977 52 9595, 36
Palygon E: LUAMGPHRABAMNG 19950541248.19 19950.54
Falygon 41 0UDOMHAY 11782408756, 75 1178241
Folygon 2i PHOMGSALY 15454654827 43 15454.65
Falygon 81 xAYABOURY 15524626624, 79 1552463
Folygon 91 XIEMGRHUANG 12701557617 .82 12701.96

G

#2 Attributes of Lao-c.shp

Shame | Aot Fhaame Sy SiF A
fFPolpgon #1111 BOLIKHAM=AY 1563483514013 15694 84
Polugon 12 KHAMMUAME 1670BERER44.05 16708, 86
Polygan 10 WIENTIAME 1257846347503 12578.46
Polugon 18 =avSOMBOUM S.R. Tr01625289.21 i Rax
Polugon 1:WIEMTIAME MUM. IBEI 5221877 3583.15

d|

&8

#2 Attributes of Lao-s.shp

Shame | Pt Fhame S m S Am
Polygan 17 L ATTAPEU 9541933838.71 9541.93
Polugon 16 CHAMPASAK 14966441773.95 14966, 44

= | Palygaon 14: SaRAVANE 1015309426301 10153.09
Polygan 13 SAVANNAKHET 21378124707 .83 2137812
Polugon 15: SEKOMNG 838807269137 8388.07

Jl

-1 -Observe their attribute tables



3.2 Create whole administration boundary by mefiti

- In View menu, click
GeoProcessing Wizard
-Choose Merge Themes
together option

-Then click Next>> button
-In next window, press Shift
Button and click all three
Themes

-Select Based field and locate
The output theme directory
-Then click Finish button

£ Attributes of Lao-n.shp /
Shaae | Pt Fhadans Sy Sig ke -

Pualygon 5:BOKED F982252954.09 B982 25 |
Pualygon 7 i HUAPHAMH 17504314822 48 1750421
Folygon 3 LUAMGMAMTHA 9595355977 52 9595.36
Palygon 6 LUAMGPHRABANG 1935054124819 19950 54
Pualygon 4 OUDOM>AY 11782408756, 75 1178241
Puolygon 21 PHOMGSALY 15454604827 43 15454 65
Folygon 8 xAYABOURY 16524626624.79 15624 63
Pualygon 9 XIEMGFKHUAMG 12701957617 82 1270196 -
1 I+

! GeoProcessing

ics Center

F Technology

Xl

Choose a GeoProceszing operation,
then click the Mest button to choose
options.

~

Dizzolve features baged on an attribute

iMerge themes together ;

Clip one theme bazed on another
Intergect bwao themeas
Union bwo themes

.
-
~
-
P

Azzign data by location

About Merge

This operation appends the
features of two or more themes
into a gingle theme. Attributes
will be retained if they have the
SAMEe Name.

i Ay

[Spatial Join) Theme1 Theme2 Cutput Theme
More about Merge |
Help... | Cancel 4 Had | et >ﬂ
! GeoProcessing x|

1] Select at least bwo themes to menge:

2] Specify the output fils:
Output File: | d:\training2004%miniprojectslaos. i\

MOTE: The fields in the output will be
the zame fieldz az the first theme.

About Merge

This operation appends the
features of two or more themes
into & single therne. Attributes
will be retained if they have the
Sarme name.

Y v

Thermel Theme2 Cutput Theme

tore about bMerge |

Help... |

Cancel | << Back | Finii |




3.3 Display the administration boundary

ﬂ Laos.shp

-Display output theme
(Lao.shp)
-Open Theme Table

Geoinformatics Centet
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]

| Lao-s.shp

]

_| Lao-ns=hp

]

| Lao-cshp

]

alle,

el W Fhdas ST m S A
ﬁ'_-;u_lg,!qnn 1:WIEMTIAME MUM. ABENEL218.77 358316
Palygan 2 PHOMGSALY 15454654827 43 15454 65
Palygan 3t LUANGHAMTHA 9535305577 52 959536
Palygan 4 OUD DM 1178240875675 11782 41
Palygan 5iBOKED B332252954.09 B932.25
Palygan 6 i LUAMGPHRABAMG 1935054124819 19950.54
Palygan 7 i HUAPHAMH 17504314822 48 17504.31
Palygan 8 RATYABOURY 1552462662479 15624 .63
Palygan i ®IEMGEKHUANG 12701957617 82 12701.96
? | Polygon 10 YIEMNTIAME 1257846347503 1267846
| Palygon 11 | BOLIKHAK=AY 1569483514013 15694.84
Palygan 12 KHAMKIUAME 167085684405 16706.56
Palygan 13§ SAMANMAKHET 21378124707 83 2137812
Palygan 14 | SARAMAME 1015309426301 10153.09
Palygan 15 SEKONG 838807269137 a38a.07
Palygan 16 | CHAMPASAE, 1496644177395 1496644
.| Palygan 17 i ATTAPEU 9541932838 A1 9541.93
Palygan 18 =AYSOMBOUMN 5.R. 7701525289 41 7701.53
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4.Clip

4.1 Open new view window and Add Themes
4.2 Clip buffer of road with provincial boundary
4.3 Display clipped theme
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4.1 Open new view window and Add Themes

-Add road buffer theme which operated from the previous steps
(Buf_rd5km.shp)
-Add “Province.shp”

«] Buf_rdskm.shp_*

ﬂ Frovinze.shp
L]

|41




4.2 Clip buffer of road with provincial boundary Scmetee

! GeoProcessing x|

- I n VI eW m e n u ) C I I C k Choose a GeoProcessing operation, About Clip

then click the Mext button to chooze

! This operation uses a clip
ophianz. . .
theme like a cookie cutter on

GeOPrOCESSIng leard " Diszolve features based on an attribute your input theme. The input

¢ Merge themes together theme's attributes are not

-Choose Clip one theme o e '/% Q @
based on anothers option C sty i T

[Spatial Join] Theme Theme Theme

-Then click Next>> button oo sseuCio |
Help... | Cancel 4 Bt | Mext >>w|

-In next window, select “Province.shp”
as Input theme to clip x

1] Select input theme to clip: Ahout Clip

-Select “Buf_rd5km.shp™ as a [Foies 7 W | | e cpion uses aclp

[T Uze Selected Features Mol therme like a cookie cutter on
Murmber of Festures. 1 your input theme. The input

po Iygon Overl ay theme 2] Select a polygon overlay therme: ;TIEETEEE;.S Fitnibutes are ot
-Specify the output name and '

<-0-8
d i re Cto ry 3] Specify the output file Theme Theme Theme

Input Clip Result
Output File: |d:'\trainingEDDd'\miniprDiect\c@ ors sbout Ci |
are aboLy Ip

-Then click Finish button o | k

Murnber of Features: 1




. . Geoinformatics Center
4.3 Display clipped theme
v Blu:|f_rd5 shpt ~ _ .
] Frovinee shp
-Display output theme =

(Clip_buff_rd.shp)
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9. Intersect

5.1 Open new view window and Add Themes
5.2 Intersect buffer of road and buffer of district hospitals
5.3 Display intersected themes

5.4 Calculate new area
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5.1 Open new view window and Add Themes i

-Open new view ¥l Butsniokmeny 2

window o But_rdSkm.shp

-Add themes, — O

“Buf_dh10km.shp”

and “Buf_rd5km.shp” ()
72 Attributes of Buf_dh10km.... [l[=] E O

-Observe their attribute tables

GACIA 1T L Lal200.4
TTAT IO Oo T




5.2Intersect buffer of road and buffer of district HeSptaks"

= - #! GeoProcessing x|
- In View menu, click
. . Choose a GeoFiocessing operation, ?ﬁ:";‘p!}':;?ir;:gtuts an input
Geoprocess I ng WI Zard thetir;r?!ck e et Button @ cheose theme with the features from

an averlay therme to produce

™ Dissolve features based on an attribute an output theme with features
- C h I t t t th " Merge themes togsther that have attribute data from
O Ose n e rseC WO e m eS o _I;Iip one theme based an anather both themes.

- & dntersect e themes:
Optlon  WNpn two themes /’,é/.;.@:@

-Then click Next>> button

[Spatial Jain) Input Overlay  Output

More about [ntersect |

Help... | Cancel £ B Mest »» \ !

-In next window, select “Buf_rd5km.shp”
as Input theme to intersect £
-Select “Buf_dh10km.shp” as a el | | T e e am o

[ Use Gelected Features Gr theme with the features from
an overlay theme to produce

a.n Ove r I ay theme Number of Features: 1 an output theme with features

2] Select an overlay theme: that have attribute data from

| Buf_dh10km.shp bath themes.

-Specify the output name and E Y
pecify p 3 1 ®-@

Mumber of Features: 1

d i re Cto ry 3) Specify the output file Input Ovetlay  Qutput

Output File: | d:straining2004\miniprojectiin @
h I - k F - - h b taore about |ntersect |
-T e n C I C I n I S Utto n Help... | Cancel | << Back Firizh *
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5.3 Display intersected themes
o Int_buf_rd_dhshp =
-Display output theme s ®
(Int_buf rd_dh.shp) e | @ G Ve
O®
O

Input Theme to Intersect = buf rd5km.shp
Overlay Theme = buf_dh10km.shp

+ Int_bui_rd_dhshp %

|
| Buf_dhi0km.shp
" ¢
| Buf_rdSkm.shp ‘ .
£ W
O ® )
\

7 Seatands
Palygon 0 5.0000 ; 0 10.0000




£ Yiewd

] Int bui_dh_rd.shp |

| Int_buf_rd_dh.shp

] Bui_dhiOkmshp
-Display output theme cil s
(Int_buf dh_rd.shp)

[

Input Theme to Intersect = buf _dh10km.shp
Overlay Theme = buf rd5km.shp

o1 Int_bui_dh_rd.shp _*|

_| Int_buf_rd_dh.zhp

| Buf_dhidkmshp Q
- )
£ Attributes of Int_buf_dh_rd.shp N [=l Q;j D Q Q
Shape Feaifendic 7 Sraffercti Q
10,0000 N @

Falygon 0 10.0000 1] 5.0000 0

Faolygon 0 10.0000 1] 5.0000 0 10.0000

Faolygon 0 10.0000 1] 5.0000 0 10.0000 \i
Palygon 0 10.0000 1] 5.0000 0 10.0000 Q
Falygon 0 10.0000 1] 5.0000 0 10.0000

Faolygon 0 10.0000 1] 5.0000 0 10.0000

Faolygon 0 10.0000 1] 5.0000 0 10.0000

Palygon 0 10.0000 1] 5.0000 0 10.0000 =

Falygon 0 10.0000 1] 5.0000 0 10.0000

Faolygon 0 10.0000 1] 5.0000 0 10.0000

Faolygon 0 10.0000 1] 5.0000 0 10.0000




5.4 Calculate new area

Due to the original data is

Latitude-Longitude projection. For an
accurate area unit,the data need to be

projected.

-In File menu, check Projection
Utility Wizard in Extensions..

sub-Menu. Click OK

Scale 1:]1.845,093

o Int_bui_dh_rd.shp *|
1

| Int_buf_rd_dh.shp

_ | Buf_dhidkm.=hp

Q
1= NI

-Load ArcView Projection Utility in
File Menu. Ckick Next> button

Available Extensions:

| Metwork Analyst
| MITF Image Support

il ojection Utiliy \wizard
| & to kap Woarld File Creataor

_ | Report \Writer
| Theme Snapping Toolz
| Spatial Analyzt

About:

Reset I

[~ Make Default

#} Arc¥iew GIS 3.3

Edit  Yiew TIheme Grap
Lloze
Cloze all

Setworking Directary...
Save Project Ctrl+5

Save Project As...

Extensions. ..

Brint...
Pritt S etup...
Expoit. .

Manage Data Sources...

Arciiew Projection Utiliw. ..

E it

= arcYiew Projection Utility - Step 1

=10l x|

Select which shapefilels) you would like to reproject into another coordinate system, If
multiple files are specified, they must exist in the same directory and be in the same

coordinate systen,

Directary
d:\trainingZ004 miniproject

Browse...

1]

1 Filels)

Count | Coordinate Syskem

Help I

Cancel |

< Back

hex




=101 ]

= prcYiew Projection Utility - Step 2

Wwhat is the current coordinate swskem of wour shapefilelsi?

[¥ Show Advanced Options
Name Parametersl Datuml EIIipsnidI

Zoordinate Syskem Twpe
{¥ Geographic
" Projected

Mame

Units
IDegree [910z2] j
Factor: 0.017453292519943

Cancel

Help |

« Back, | ﬁextﬂ

Geoinformatics Centet

Asian Institute of Technology

-Select GCS_WGS 1984(4326) as
The current coordinate system in Step?2

Arc¥iew Projection Utility x|

“fou have just specified a coordinate system For vour shapefilefs). Would wou like bo save the coordinate system information
now? Press Yes bo save this new information with vour input shapefile(s),

=101 %]

& prc¥iew Projection Utility - Step 3

Select the new coordinate system For your new shapefilefs).

¥ Show Sdvanced Options
Mame Parametersl Datuml EIIipsnidI

Coordinate System Type
™ Geographic
f»_Projected

Marme

;K

[WiGs_1984_UTM_Zone_48n [32648]

Uniks
[Meter [3001] |
Factor: 1.0

Cancel < Back

Help |

-In Step3 window, select coordinate
System Type is Projected, Name
WGS 1984 UTM_Zone 48N(32648)

=101

= ArcYiew Projection Ukility - Step <

where do wou want to save your shapefile(s)? If multiple files were specified, the new
shapefiles must be writken ko a directory different than the original directory,

Mew shapefile name
d:ibrainingZ004miniprojectiint_buf_dhrd_utm.shp

Cancel

Help |

< Back Mexk = |
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= prcYiew Projection Utility - Summary — |1 3] [echnology

[k, Flease werify the Following settings are carrect, Then, press the Finish bukton to
beqin reprajecting the listed shapefilels).

-Click Finish button in Summary e s s ae e :

d:htrainingz00diminiproject

Wi ndOW int_buf_dh rd.shp

Input Coordinate System:

-Click OK button in Complete T

Window o oo e
-Open New Window and add

Output theme

(Int_buff _dhrd_utm.shp)

none

Output Geographic Transformatiomn: LI

Help Print Cancel | < Back

& YiewlD

= arcYiew Projection Utility - Complete - |E||5|

o] Int_tuf_dhrd_utm.s_*

1]

@‘I Q)

Finished processing wour shapefiles,

Projection Utility
9 Do wou want to add your projected data? ﬁ

\




&1 Attributes qunI:_huf_dhrd_ul:m.s ................. i i Centﬂf
-Open output’s attribute table ‘ e

Folygon ] ]
.- . e Palygan i 10.0000 i 10.0000
-Select Start Edltlng in Table menu Falygan i 100000 i 10,0000
. . . . . Palygan i 10.0000 i 10.0000
- Palygon i 10.0000 i 10.0000
Click Add Field in Edit menu, input Cebieen 0 100000 0 100000
. ey . Palygan i 10.0000 i 10.0000
Field Definition then click OK W Eoipgon i 10,0000 i 10,0000
Palygan i 10.0000 i 10.0000
m & ArcYiew GIS 3.3 Palygon 1] 10.0000 1] 10.0000
o . ElIE lal:lIE F]Eld ETDI F'D|_I.ng:lr‘| 1] 10.0000 1] 10.0000
_ Field ®Toolks o —
! Eroperties. .. E —|_ Copy Chl+C 4 Field Definition x|
= Faste [Chrls
= Lhart.. \—>
#L  UndoEdt CulZ |:> MName: | Area oK
RedoEdt  Chley
E eda Ed o Type: |Numl:|er ;I

i Save Edits —m Cancel
|_< AAA DA Chel A wfidth: |—12

Decimal Flaces: I a

-Activate on new field name, click &
-Input an expression to calculate area [AREA] = [Shape].returnarea
| -Then Click OK

#2 Field Calculator
Fields Type Requests 3 - HeL -
&1 Attributes of Int_buf_dhrd_utm.shp
[ld ] ﬁh Nulmber : - Shape Bufferdig_ .............. E uffen:hg .............
(Bufferdis. ] " Sting : — Palygon 0 10,0000 0 10.00 5343254.33
[Id] " Date N |::> Palygon I 10,0000 I 10,0000 § 1345350318.91
[Bufferdiz] ¢ Palygon 1] 10,0000 1] 10,0000 ; 197108387 87
[Area] i Palvgon 1] 10,0000 1] 10,0000 257573567 98
<= hd Palygon I 10,0000 I 10.0000; 3165426092
Palygon I 10,0000 I 10,0000 ; 136369369 60
( [Ghape] retumared = i Palygon 1] 10,0000 1] 10000 90320304.23
) Palvgon 1] 10,0000 1] 10,0008 ; 19260953678
Caticel | Palygon 1] 10.0000 I 1 D.DDD&\'I 90435529.28
- Palygon I 10,0000 I 10,0000 2@399520?.05
Palygon 1] 10,0000 1] 10,0000 ; 21 (G353 29
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6.Union

6.1 Open new view window and Add Themes
6.2 Union buffer of road and buffer of district hospitals
6.3 Display union themes

6.4 Analyze the output
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6.1 Open new view window and Add Themes

-Open new view
window

-Add themes,
“Buf_dh10km.shp”

and “Buf_rd5km.shp”

+ Buf_dhidkmszhp

L]

+ Buf_rdSkm.zhp

L]

Y

2 Akttributes of Buf_dhl10km.shp

Frafand

10.0000 ¢

-Observe their attribute tables

&2 Attributes of Buf_rd5km.shp




6.2 Union buffer of road and buffer of district hospitats %

! GeoProcessing x|

Choose a GeoProceszing operation, About Union

- In View menu, click
GeoProcessing Wizard s o an g homo il e

palygons from an averlay theme
to produce an output theme that

'Choose U n i On tWO themes " Merge themes together contains the attributes and full

™ Clip one theme bazed on another extent of both themes.

- ™ Interzect bwo themes
option o 41 OB
- Spatial Join naut verla utput
-Then click Next>> button S oty B

tore about Union

|
Help... | Cancel | 4 Had | Memt = *
-In next window, select “Buf_rd5km.shp”
1] Select input theme to union: Ahout Union

. . i GeoProcessing |
as Input theme to union
= Se I eCt “ B Uf_d h 1 O km . S h p 7 aS - Llsted features anly IP;SHI:;EELTEZ ;DETEtIEii ;e e

polygons from an ovetlay theme

™ Disgsolve features based on an attibute

] Murnber of Featurss: 1 to prn_u:luu:e an output therne that
polygon overlay theme to UNION | 2sstpsnoms venetower % crtent o1 o therss

-Specify the output name and S - 9@

3] Specify the output fils:

d I re Cto ry Outpuit File: |d:‘\trainingEDthminipruiect\ur@

2

-Then click Finish button b | T [ i |

Input Owerlay  Output

More about L nion |




6.3 Display union themes

-Display output theme

(Un_buf _rd_dh.shp)

i1 Attributes of Un_buf_rd_dh.shp
S ir
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] Un_buf_rd_dh.shp [~
[ ]

_| Buf_dh1Okmszhp

L

_ | Buf_rdSkm.shp

1

Falygon 1] 5.0000 a 10.0000
Falygon 1] 5.0000 a 00000
Falygon 1] 00000 a 10.0000
_ | Polygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
Falygon 1] 00000 a 10.0000
G/ AhTu0004

16 Records/Polygons



6.4 Analyze the output

Shame [ Fuastani

Palygon 0 0 N\ 10.00004
FPalygon 0 0 0.0000
Polygon 0 0.0000 0 10.0000

_ | Polygon 0 0.0000 0 10.0000
Polygon 0 0.0000 0 10.0000
Palygon 0 0.0000 0 10.0000
Polygon 0 0.0000 0 10.0000
Palygon i} 0.0000 0 10.0000
Palygon i} 0.0000 0 10.0000
Polygon 0 0.0000 0 10.0000
Palygon i} 0.0000 0 10.0000
Polygon 0 0.0000 0 10.0000
Palygon 0 0.0000 0 10.0000
Polygon 0 0.0000 0 10.0000
Palygon i} 0.0000 0 10.0000
Polygon 0 0.0000 0 10,0000 —
1] I

v
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Case2

A

#2 Attributes of Un_buf_rd_dh.shp

Palygon 0 0

Palygan 1] 5.0000 ) 1] 0.0000
Polygon O e A O HLOANG
Palygan 1] 0.0000 il 10.0000
FPaolygan 1] 0.0000 1] 10,0000
Polygan 1] 0.0000 I 10,0000
Palygon i 0.0000 i 10.0000
Polygan 1] 0.0000 I 10,0000
Palygan i 0.0000 i 10.0000
Polygan 1] 0.0000 I 10,0000
Palygan i 0.0000 i 10.0000
FPolygan 1] 0.0000 1] 10,0000
Palygan i 0.0000 i 10.0000
FPolygan 1] 0.0000 1] 10,0000
Palygan 1] 0.0000 il 10.0000
FPaolygan 1] 0.0000 1] 10,0000
1] 2

=4

v

Inside road buffer&Inside hospital buffer

Inside road buffer&Outside hospital buffer
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Case3

O

Outside road buffer&Inside hospital buffer

! Attributes of Un_buf_rd_dh.shp

Shape | A7 Fuffandtic. i Frafendi
Palygon 0 5.0000 0 10,0000
Palygon ] 5.0000 0 0.0000
Polygon 1] ful 1] N0
Palygon 0 /n.0000 0 /10,00
Palygon 0 J 0.0000 0 / 10.000
Plygan 0 0.0000 0 10,0000
Flygan 0 0.0000 0 10,0000 :
Flygan 0 0.0000 0 10,0000
Palygan 0 0.0000 i 10,0000
Palygan 0 0.0000 i 10,0000
Palygan 0 0.0000 i 10,0000
Palygon 0 0.0000 0 10,0000 :
Palygon 0 0.0000 0 10,0000
Palygon 0 \ 0.0000 0 \ 10.0000f
Palygon 0 \o. 0000 0 \ 10.000
Palygon 0 (oAl | 0 \gﬂgdn

Center

‘hnology



Loninfosmatioe f‘ mai»fr

-Add new field and input the result of
selected areas

Field ¥Tools = ArcWiew GIS 3.3
. Eile Iable Field XTo

i +
: Eroperties... I: Cut i |
i Chart... I::> ——  [Copy [Etrl+2
B |_ Faste [Chrlass ]
Bi SaveEdis Bl UndoEdit Oz ‘
#2 Field Definition x| Fedo Edit  Chl+y'

Mame: | &nalysiz <:| nm
AAd Dmard Tl

Type: [ Sting =] Carcel | ew GIS 3.3

\widthe I_ED ﬁ.i Jable Field XTool: Window Help

~
[] T 16 zelected

#} Attributes of Un_buf_rd_dh.shp

Shape Id_ Bufferdiz_ Bufferdis

Palpgan ] 5 0000 ] 0.0000

Polwgon 1] 50000 1] 10,0000
@ ricld colci = Polygon 1] 0.0000 1] 10,0000 Ins?de OH sew?cable area but Duts?de road buffer
s Palygon 0 0.0000 0 10,0000 ¢ Inzide DH zervicable area but outzide road buffer
Fields Tupe Requests Palygon 0 0.0000 0 10.0000 ¢ Inzide DH zervicable area but outside road buffer
& Nurber P " Palugon ] 0.0000 ] 10,0000 ¢ Inside DH zervicable area but outzide road buffer
fd ] £ Shing v Palugon ] 0.0000 ] 10.0000¢ |nside DH servicable area but outside road buffer
[Bufferdis_] T Paolpgon 1] 0.0000 1] 10.0000 ¢ Inside DH servicable area but outside road buffer
[1d] € Date Palwgan 1] 0.0000 1] 10,0000} Inside DH zervicable area but outside road bufter
[B““e'c_“S] ! Polygon 1] 0.0000 1] 10,0000 Inside DH servicable area but outside road buffer
[Analysis] : Ll Palygon 0 0.0000 0 10,0000 ¢ Inzide DH zervicable area but outzide road buffer
<= Palygon 0 0.0000 0 10,0000 Inzide DH zervicable area but outzide road buffer
[#nalysis] = Palugon ] 0.0000 ] 10,0000 |nside DH servicable area but outside road buffer
"Ingide DH servicable area but outside road buffer'| - 0k I Palugon ] 0.0000 ] 10,0000 ¢ Inzide DH servicable area but outzide road buffer
Palugon ] 0.0000 ] 10.0000 ¢ Inside DH servicable area but outside road buffer
&I Polwgon 1] 0.0000 1] 10,0000 |nside DH servicable area but outside road buffer
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7. Spatial Join

7.1 Open new view window and Add Themes
7.2 Join attribute table to district centers

7.3 Display spatial joined table
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7.1 Open new view window and Add Themes

] District_centershp *

-Open new view B —
window —
-Add themes,
“District_center.shp”
and “Pop_district.shp”

é! Attributes of District_center.s... [ _ |

FRaanes i

FPoint. 13 SAVANMNAKHET ! Attributes of Pop_district.shp
Faint 13§ SAVANMNAKHET Shape Jm— RS
Faint 131 SAVANMAKHET Polygon 1765107 131 SAVANNAKHET S I
Fuaint 13 SavaNMAKHET Palygon £95.94F 131 SAVANMNAKHET 1317 | aibouri 47073 8F
Frint 13 A ANMAKHET FPalygan 1452 315 137 SAVANNAKHET 1313} Atzaphon 40290 a4

; Palygan 2266702 137 SAVANNAKHET 1305 | Hepon 41537 160
Faint 13§ SAVANNAKHET

: Palygan 1082 417 137 SAVANNAKHET 1302 i Outhournphan 75030 109
F":'!”t 13 SAVANNARHET Palygon 993 077 131 SAVANNAKHET 1315 | Phalansai 22761 73
Faint 13} SAVANMAKHET Palvgan 700.938 13 SaVANMAKHET 1303 | Atsaphangthang 25640 43
Paint 13 SavANMNAKHET Palygan 3372125 137 SAVANNAKHET 1304 | Phin 29512 146
Paint 13 SavAaMMNAEHET Palygon E31.611 13 SANVAMNNAKHET 1307 ¢ Khanthabour 74352 96

: Palygon 1043 759 137 SAVANNAKHET 1309 Champhon 87719 166
P':'!”t 13; 3aMaNNAkHET Folygon 1710 546 13T SEVANNARHET 1506 Mong 16745 55
FPaint 13 SAVANMAKHET Folygon 12108 SR 137 EAVANNARHET T Ranboun 467 57
Point 13§ SAVAMMNAKHET Palygan 454823 13} SAVANMAKHET 1314 | ¥aiphouthang 26331 41
Point 13isavarMAEHET Palygan 1635.517 13 SAVANNAKHET 1308 | Songkhon 80373 162

4 *




7.2 Join attribute table to district centers

- In View menu, click
GeoProcessing Wizard
-Choose Assign data by
location

-Then click Next>> button

#} GeoProcessing

Geoinformatics Centet

Asian Institute of Technology

x|

Chooze a GeoProceszing operation,
then click the Mest button to choose
options.

" Diszolve features bazed on an attibute
" Merge themes together

™ Clip one theme based on another

" Intersect bwo themes

= Union bwo thermes

0¥ Assign data by lacation
tial Jqir)

About Assign Data By Location
This operation joins only the

data for features of Theme? to
the features of therme1 which
share the same location.

o

o L]
Themel Theme2
+ =
Table2  Joined Table

Tahlel

About Aszign Data by Location

Help... |

Cancel 4 e

-In next window, select “District_center.shp”

as a theme to assign data
-Select “Pop_district.shp” as
a theme to assign data from
-Then click Finish button

i} GeoProcessing

Agzigning data by location iz alzo
called Spatially Joining data. & join
iz made if the specified zpatial
relationzhip iz detected.

1] Select a theme to azsign data bo:

| Digtrict_center.shp

2] Select a theme to azsign data from:

| Pop_district. shp

Diata will be aszsigned bazed
on whether it iz inzide

:k
K

About Assign Data By Location
This operation joins only the

data for features of Theme2 to
the features of theme? which
share the same location.

o
o @

Themel ThemeZ
+ =
Tablel TableZ Joined Tahle

About Azsign Data by Location |

Help... |

Cancel << Back




7.3 Display spatial joined table

-Open attribute table of “District_center.shp”

-To delete join table

Select Remove All

Joins in Tables

Menu.

el

@@ Attributes of District_center.shp

Geoinformatics Center

Asian Institute of Technology

Shama|  Frogk Fivame Aaaz Froe Fhame Lot Srazana Tt | A s
Pairt 131 SAVAMMNAKHET 1765107 131 SAVAMMNAKHET 1312 ilabouri 24298 EHE
Poirt 131 SAVAMMNAKHET 3372125 13 SAVAMMNAKHET 1304 ¢ Phin 39513 146
Pairt 13 SAVAMMNAKHET 2266782 13 | SAVAMMNAKHET 1305 | Hepan 41537 160
Point 131 SAVAMMAKHET 1635.817 13 SAVAMMNAKHET 1308 Songkhon 85373 162
Poirt 131 SAVANMNAKHET 700,938 13 { SAVANMNAKHET 1303 ! Atzaphangthong 25640 49
Paint 13§ SAVAMMNAKHET 398.077 131 SAVAMMAKHET 1315 Phalarwai 22761 73
Poirt 131 SAVAMMNAKHET 1700.596 13 SAVAMMNAKHET 1306 ¢ Mong 16745 99
Pairt 13 SAVAMMNAKHET 1082 17 13| SAVAMMAKHET 1302 | Outhaurphian 7a080 109
Point 131 SAVAMMAKHET 1452 316 13 SAVAMNMNAKHET 1313 Atsaphon 40290 94
Pairt 13 SAVAMMNAKHET 1049 755 13 | SAVAMMNAKHET 1309 ¢ Champhan 87713 166
Paint 13| SAVAMMNAKHET 2115852 13} SAVAMNAKHET 1307 | Thapangthang 23330 a4
Poirt 131 SAVAMMAKHET 1205960 13 SAVAMMNAKHET 1310 Hanbaur 34167 97
Pairt 131 SAVAMMNAKHET 595,946 131 SAVAMMNAKHET 1311 | Haibouri 47073 a6
Poirt 131 SAVAMMAKHET 454,823 13 SAVAMMNAKHET 1314 ¢ Raiphouthong 26831 41
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Case Study

Finding the suitable location for a new hospital

Criteria
1. Not away from road than 1 Km

2. Away from existing hospitals than 1.5 Km.

3. Landuse are not water bodies, forest



